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#####################################################################

DELL SERVER MANAGEMENT PACK SUITE 4.1 FOR MICROSOFT
SYSTEM CENTER OPERATIONS MANAGER 2007 SP1/R2 and 
SYSTEM CENTER ESSENTIALS 2007 SP1/2010 - README FOR DELL CHASSIS 
MANAGEMENT CONTROLLER MANAGEMENT PACK

#####################################################################
#####################################################################
Version 4.1
Release Date: December 2010

This Chassis Management Controller readme provides information for 
the Dell Chassis Management Controller Management Pack version 4.1 
which can be imported to Microsoft System Center Operations Manager
(Operations Manager) 2007 SP1/R2 and System Center Essentials 2007 
SP1/2010. All references to Operations Manager are also applicable to 
System Center Essentials.

This file contains updated information for your "Dell Server 
Management Pack Suite Version 4.1 For Microsoft System Center 
Operations Manager 2007 SP1/R2 and System Center Essentials 2007 
SP1/2010 User’s Guide" and any other technical documentation included 
with the Dell Management Pack Suite for Operations Manager.

NOTE: You cannot apply Dell Management Pack Suite 4.1 as an upgrade 
over Dell Management Pack 3.x or any other previous versions of Dell 
Management Pack. Importing the Dell Management Packs v4.1 over the 
Dell Management Packs v3.x is not a supported configuration.

#####################################################################
#####################################################################

The Dell Chassis Management Controller Management Pack enables 
Microsoft System Center Operations Manager to discover and monitor 
the status of Dell Chassis Management Controllers and Dell Modular 
Chassis Remote Access Controllers on a defined network segment. 
The management pack includes icons describing Dell Chassis
Management Controllers and its components; failure and pre-failure 
alerts, and allows you to assess, respond to, and ensure the availability
of Dell Chassis Management Controllers monitored in the Operations 
Manager environment. In addition to improved availability, the 
Management Pack enhances the ability to monitor and manage multiple 
Dell Chassis Management Controllers in a single management solution.

This file contains the following sections: 

* Criticality 

* Minimum Requirements

* Release Highlights
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* Installation/Un-Installation

* Operating System Support

* User Notes

#####################################################################
CRITICALITY
#####################################################################

- Recommended

#####################################################################
MINIMUM REQUIREMENTS
#####################################################################

This section provides information about the minimum requirements for 
installing and using the Dell Chassis Management Controller Management 
Pack for Microsoft System Center Operations Manager 2007 SP1/R2 
and System Center Essentials 2007 SP1/2010.

=====================================================================
Requirements
=====================================================================

* Dell OpenManage Server Administrator (OMSA) or DRAC Tools:

OMSA or DRAC Tools are required on the Management Server to discover
CMC and DRAC/MC Server Modules and Free slots.  The recommended version of
Dell OpenManage Server Administrator or DRAC Tools is 6.4.  However,
you can use any version between 5.5 to 6.4.

NOTE: If a Management Server has Server Administrator or DRAC Tools version
lesser than 6.2, then you will not be able to use Active Directory Logins for
discovering CMC and DRAC/MC Server Modules and Free Slots. Instead use 
local user accounts for configuring the Run As Accounts.

=====================================================================
Supported Dell Devices
=====================================================================

* Supported Device: 

Dell Chassis Management Controllers with firmware v2.1 and above and 
all Modular Chassis Remote Access Controllers with firmware v1.5
and above.

#####################################################################
RELEASE HIGHLIGHTS
#####################################################################

*  Representation of Server Modules and free slots under Dell Chassis
   Management Controllers and Dell Modular Chassis Remote Access
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   Controllers

*  Correlation of the Server Modules under Dell Chassis Management 
   Controllers/ Dell Modular Chassis Remote Access Controllers with
   Dell Windows Servers on System Center Operations Manager 2007 R2.

#####################################################################
INSTALLATION/UN-INSTALLATION
#####################################################################

=====================================================================
Installation
=====================================================================
---------------------------------------------------------------------
Downloading and extracting Dell Server Management Pack Suite v4.1
---------------------------------------------------------------------

1. Download the Dell Server Management Pack Suite v4.1 from the Dell 
Support website at support.dell.com.

2. Copy the downloaded file, 
Dell_Server_Management_Pack_Suite_v4.1_A00.exe to a temporary folder
(say C:\Temp) on your local system.

3. Run the Dell_Server_Management_Pack_Suite_v4.1_A00.exe and extract
the Management Packs, README files and utilities.

-------------------------------------------------------------------------
Importing/Upgrading the Dell Chassis Management Controller Management Pack 
and Chassis Blade Correlation Utility
-------------------------------------------------------------------------

To import the management pack:

1. Launch System Center Operations Manager Operations Console or
System Center Essentials Console.

2. From the navigation pane, click Administration.

3. Expand Administration, right click Management Packs, and select
Import Management Packs.

4. Click Add. Select the Add from disk option.

5. Type or browse to the location of the Management Pack/utility files,
to which you extracted Dell_Server_Management_Pack_Suite_v4.1_A00.exe.

6. Select the Management Pack/utility you want to import, and click Open.
The Import Management Packs screen appears with the selected 
Management Packs/utilities displayed in the Import List.

7 Click Install.
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NOTE: If Dell Chassis Management Controller Management Pack version 4.0
is already installed on SCOM, the Import process will automatically upgrade
the management pack to version 4.1

NOTE: Chassis Blade Correlation Utility is supported only on System Center
Operations Manager 2007 R2

---------------------------------------------------------------------------
Configuring the Dell Chassis Management Controller Management Pack for 
discovering Server Modules and Free Slots
---------------------------------------------------------------------------

Create Run As Profiles and Run As Accounts to select users with privileges
that are needed to discover CMC and DRAC/MC server modules and free slots. 

1. Create a Simple Run As account that has privileges to connect to the CMC
and/or DRAC/MC chassis. You can also create a Simple Run As Account with
Active Directory user credentials when the CMC and/or DRAC/MC Chassis is 
configured to work with AD. You can also use Basic or Digest Run As Account
types for configuring the user credentials.

2. Associate the CMC Chassis Run As accounts with the "Dell CMC Login Account" 
Run As Profile included in the Dell Chassis Management Controller Management
Pack. Target the configuration with respect to the Dell CMC class. For
SCOM 2007 R2/SCE 2010, you can select More Secure option in Run As Account
configuration, so that you can selectively distribute the configuration to
specific management servers.

3. Associate the DRAC/MC Chassis Run As Accounts with the "Dell DRAC/MC Login
Account" Run As Profile included in the Dell Chassis Management Controller
Management Pack. Target the configuration with respect to the Dell DRAC/MC
class. For SCOM 2007 R2/SCE 2010, you can select More Secure option in
Run As Account configuration, so that you can selectively distribute the
configuration to specific management servers.

4. To enable server module and free slot discovery for CMC, enable the
Discovery Rule "Dell CMC Slot Discovery". It is disabled by default.  
To enable server module and free slot discovery for DRAC/MC, enable the
discovery rule "Dell DRAC/MC Slot Discovery".

---------------------------------------------------------------------
Pre-requisite for Chassis Modular Server Correlation
---------------------------------------------------------------------

In a distributed SCOM environment where you have a multiple Management Server,
Single Management Group scenario, you must enable server proxy on the MS where 
you discover and monitor the CMC and/or DRAC/MC chassis.

To enable server proxy:

1. Launch System Center Operations Manager 2007 R2 Operations Console.

2. From the navigation pane, click Administration.
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3. In the Administration pane, click Management Servers.

4. Select the MS where you have discovered the CMC and/or DRAC/MC Chassis.

5. Right-click and then select Properties.

6. In the Management Server Properties dialog box, click the Security tab.

7. Select the check box to allow the server to act as a proxy and discover
managed objects on other computers.

8. Click OK.

For latest information on installing the Dell Management Pack Suite 4.1
for Microsoft System Center Operations Manager 2007 SP1/R2 and System
Center Essentials 2007 SP1/2010, see the "Dell Server Management Pack
Suite Version 4.1 For Microsoft System Center Operations Manager 2007
SP1/R2 and System Center Essentials 2007 SP1/2010 User’s Guide".

=====================================================================
Un-Installation
=====================================================================
Before deleting Chassis Management Controller MP
----------------------------------------------------------------------

Dell CMC MP includes two Run As Profiles for CMC and DRAC/MC respectively.
All created Run As Account associations gets added to 
Microsoft.SystemCenter.SecureReferenceOverride Management Pack. Deleting 
CMC MP with similar Run As Account association having dependencies with
Microsoft.SystemCenter.SecureReferenceOverride, would result in conflicts.

To delete CMC MP, follow the steps below:

1. Launch System Center Operations Manager Operations Console or
System Center Essentials Console.

2. From the navigation pane, click Administration.

3. Expand Administration, right click Management Packs

4. Select Microsoft.SystemCenter.SecureReferenceOverride MP, click
Export and save it as a local file.

5. Delete the Microsoft.SystemCenter.SecureReferenceOverride MP.

6. Edit the saved MP in the SCOM Authoring Console by deleting 
   the following overrides and references:

   - Navigate to Health Model, select Overrides.

   - Delete all overrides with Dell.ModularChassis.CMC or
     Dell.ModularChassis.DRACMC references.

   - Open File Menu, select Management Pack Properties which launches
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     Microsoft.SystemCenter.SecureReferenceOverride Properties dialog. 

   - Click the References Tab, and delete Dell.OutOfBand.CMC reference

   - Open File Menu, select Save

7. Re-import the edited Microsoft.SC.SecureReferenceOverride MP.

For latest information on un-installing the Dell Management Pack Suite
4.1 for Microsoft System Center Operations Manager 2007 SP1/R2 and
System Center Essentials 2007 SP1/2010, see the "Dell Server
Management Pack Suite Version 4.1 For Microsoft System Center
Operations Manager 2007 SP1/R2 and System Center Essentials 2007 
SP1/2010 User’s Guide".

----------------------------------------------------------------------
Deleting the Management Packs
---------------------------------------------------------------------
To delete any of the Management Packs or utilities:

1. Launch System Center Operations Manager Operations Console or
System Center Essentials Console.

2. From the navigation pane, click Administration.

3. Expand Administration, right click Management Packs

4. Select the Dell Management Pack/utility you want to delete from the
Management Packs pane.

5. Right-click the selected Dell Management Pack/utility and click Delete.

After deleting a Management Pack/utility, Dell recommends closing and
reopening the SCOM Console.

NOTE: Deleting any of the Management Packs may affect the scope of
some user roles.

#####################################################################
OPERATING SYSTEMS SUPPORT
#####################################################################

List of Operating Systems supported on the Management Station:

- Windows Server 2003 SP2, Standard x86 Edition
- Windows Server 2003 SP2, Standard x64 Edition
- Windows Server 2003 SP2, Enterprise x86 Edition
- Windows Server 2003 SP2, Enterprise x64 Edition
- Windows Server 2003 SP2, Datacenter x86 Edition
- Windows Server 2003 SP2, Datacenter x64 Edition
- Windows Server 2003 R2 SP2, Standard x86 Edition
- Windows Server 2003 R2 SP2, Standard x64 Edition
- Windows Server 2003 R2 SP2, Enterprise x86 Edition
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- Windows Server 2003 R2 SP2, Enterprise x64 Edition
- Windows Server 2003 R2 SP2, Datacenter x86 Edition
- Windows Server 2003 R2 SP2, Datacenter x64 Edition
- Windows Server 2008, Standard x86 Edition
- Windows Server 2008, Standard x64 Edition
- Windows Server 2008, Enterprise x86 Edition
- Windows Server 2008, Enterprise x64 Edition
- Windows Server 2008, Datacenter x86 Edition
- Windows Server 2008, Datacenter x64 Edition
- Windows Server 2008 SP2, Standard x86 Edition
- Windows Server 2008 SP2, Standard x64 Edition
- Windows Server 2008 SP2, Enterprise x86 Edition
- Windows Server 2008 SP2, Enterprise x64 Edition
- Windows Server 2008 SP2, Datacenter x86 Edition
- Windows Server 2008 SP2, Datacenter x64 Edition
- Windows Server 2008 R2, Standard x64 Edition
- Windows Server 2008 R2, Enterprise x64 Edition
- Windows Server 2008 R2, Datacenter x64 Edition

#####################################################################
Supported Firmware Versions for CMC and DRAC/MC Devices
#####################################################################

List of firmware versions supported for CMC and DRAC/MC devices:

- CMC     : 2.1, 2.2, 2.3, 3.0
- DRAC/MC : 1.5, 1.6

#####################################################################
USER NOTES
#####################################################################

*  Dell Chassis Modular Server Correlation utility can be imported only in
   System Center Operations Manager 2007 R2.

*  If the DRAC Console launch displays a "Page cannot be displayed"
   error, ensure that there is network connectivity from the device 
   (DRAC/MC, CMC card), and that the device is configured with a valid 
   IP address.

*  The Discovery Rule "Dell CMC Slot Discovery" is disabled for all Dell 
   Chassis Management Controllers in the Dell Chassis Management Controller
   Management Pack. Enable this rule to discover server modules and free
   slots for Dell Chassis Management Controllers after you have created
   Run As Accounts for the CMC devices in your network and associated
   them with the "Dell CMC Login Account".  For more information on 
   configuring Run As Accounts refer to "Dell Server 
   Management Pack Suite Version 4.1 For Microsoft System Center 
   Operations Manager 2007 SP1/R2 and System Center Essentials 2007 
   SP1/2010 User’s Guide"

   Note:- A user can enable the "Dell CMC Slot Discovery" Discovery if
   required by using overrides in a custom Management Pack.
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*  The Discovery Rule "Dell DRAC/MC Slot Discovery" is disabled for all Dell 
   Modular Chassis Remote Access Controllers in the Dell Chassis Management
   Controller Management Pack. Enable this rule to discover server modules
   and free slots for Dell Modular Chassis Remote Access Controllers  after
   you have created Run As Accounts for the DRAC/MC devices in your network
   and associated them with the "Dell DRAC/MC Login Account".  For more
   information on configuring Run As Accounts refer to "Dell Server 
   Management Pack Suite Version 4.1 For Microsoft System Center 
   Operations Manager 2007 SP1/R2 and System Center Essentials 2007 
   SP1/2010 User’s Guide"

   Note:- A user can enable the "Dell DRAC/MC Slot Discovery" Discovery if
   required by using overrides in a custom Management Pack.

*  The Unit Monitor "Device Status Check" is disabled for all Dell 
   Chassis Management Controllers and Dell Modular Chassis Remote Access
   Controllers in the Dell Chassis Management Controller Management 
   Pack.

   Note:- A user can enable the "Device Status Check" Unit Monitor if
   required by using overrides in a custom Management Pack.

*  "Dell CMC Slot Discovery" and "Dell DRAC/MC Slot Discovery" uses
   racadm to connect to CMC and DRAC/MC devices.  The racadm uses
   Internet Explorer Proxy Settings of SCOM Health Service user account
   to connect to the CMC and DRAC/MC Devices.  Ensure that Internet
   Explorer Proxy Settings of the SCOM Health Service user account is
   configured such that CMC and DRAC/MC devices are reachable.
   For instructions on modifying the Internet Explorer settings,
   see Microsoft KB article 135982.
   

#####################################################################
KNOWN ISSUES
#####################################################################

* After you remove the management pack, you will need to close and 
  re-open the Operations Console for complete cleanup (DF310069)

* For slots corresponding to CMCs with firmware version 2.x, only the
  default names are displayed. (DF424948)

* For CMC devices, "Service Tag" attribute value is same as the Chassis
  Service Tag. (CR414439)

* After upgrading the management packs to 4.1, you may see the Diagram
  view still displaying default icons.  You need to restart Operations
  Console with /clearcache option to see the new icons. (DF425901)

* You cannot discover slots for DRAC/MC devices with firmware 
  version 1.6 with an Active Directory (AD) account. Alternatively,
  you can discover the slots with Local User Accounts. (DF431523)
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* When remote racadm takes long time to get server module/free slot
  information from CMC or DRAC/MC device, SCOM may terminate the
  "CMC Slot Discovery" and "DRAC/MC Slot Discovery" scripts. As a
  result, you will see "Script or Executable failed to Run" alert
  in the SCOM Alerts View and some files will be left over in the
  %windir%\Temp\ChassisRemoteAccess_Logs directory on the management
  station managing the CMC or DRAC/MC device.  You can ignore the
  alert and manually remove the temporary files. (D433503)

#####################################################################

Information in this document is subject to change without notice.
(C) 2007-2010 Dell Inc. All rights reserved.

Reproduction in any manner whatsoever without the written permission
of Dell Inc. is strictly forbidden.

Trademarks used in this text: Dell™ is trademarks of Dell Inc.;
Microsoft®, Windows®, and Windows Server®,System Center Operations
Manager are either trademarks or registered trademarks of Microsoft
Corporation in the United States and/or other countries.

Other trademarks and trade names may be used in this document to 
refer to either the entities claiming the marks and names or their 
products. Dell Inc. disclaims any proprietary interest in trademarks
and trade names other than its own.

December 2010
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